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Hardware and Software Certification

The hardware and software requirements included in this installation guide were current at the time this guide was published. However, because new platforms and operating system software versions might be certified after this guide is published, review the certification matrix on the My Oracle Support Web site for the most up-to-date list of certified hardware platforms and operating system versions.

My Oracle Support is available at the following URL:

http://support.oracle.com/

You must register online before using My Oracle Support.

Use the following steps to locate the certification information for your platform:

	
After logging in, click the Certifications tab.


	
In the Certification Search pane, on the Search tab, select the following information:

	
Product: Enter the product name or select from the drop-down list of Products.


	
Release: Select the release number of the product.


	
Platform: Select the target platform by choosing from the submenu list.




For example, certification matrix for Oracle Beehive, Release 2.0, on Linux x86 Red Hat Enterprise Linux 5.


	
Click Search.

A new window appears with the product certification details.


	
Click the Release Number link to view the certified version of the product on a specific operating system version.

For example, Oracle Beehive 2.0 is certified with Oracle Database 11.1.0.7.0 on Operating System Linux x86 Red Hat Enterprise Linux 5.


	
Click the Operating System version to view Support Information and Notes.




	
Note:

Contact your Oracle sales representative if you do not have a My Oracle Support account.















Managing your E-Mails

This section provides configuration instructions for the following e-mail clients:

	
Apple Mail


	
Microsoft Outlook


	
Mozilla Thunderbird






Apple Mail

Versions: 4.5 on Mac OS 10.6; 5.0 on Mac OS 10.7

Operating System: Mac OS X 10.6, 10.7

This section describes how to connect to Oracle Beehive's IMAP and SMTP services using Apple Mail.




	
Note:

The steps provided below are for users of Apple Mail 5.0 on Mac OS 10.7. For other versions of Apple Mail, refer to Apple Mail's documentation.








To configure Apple Mail to connect to Oracle Beehive:

	
From the New Account dialog box, select IMAP from the Account Type list.


	
Enter your name and e-mail address.


	
Enter a description for your account and click Continue.


	
Enter your incoming mail server and password in the appropriate fields and click Continue. If you encounter an error stating that your mail server cannot be reached, ignore it.


	
Enter your outgoing mail server in the field and click Continue. If you encounter an error stating that your mail server cannot be reached, ignore it.


	
Click Continue.


	
Review the information you have entered. Click Go Back if you want to change any settings. Otherwise, click Continue to create your account.


	
Click Done.


	
Select your account from the list on the left-hand side and click the Account Information tab.


	
Click Server Settings.


	
Enter the port number for your outgoing mail server in the Server port field.


	
Click the Advanced tab.


	
Enter the port number for your incoming mail server in the Port field.


	
Save your changes and exit the Accounts dialog box.









Microsoft Outlook

Versions: Outlook 2003, Outlook 2007, Outlook 2010, and Outlook 2013

Operating Systems: Microsoft Windows XP, Vista (32-bit only), and 7 (32-bit and 64-bit)

This section describes how to connect to Oracle Beehive's IMAP and SMTP services using Microsoft Outlook.

For a complete Oracle Beehive experience that includes e-mail, calendar, contacts, and tasks, you must install Oracle Beehive Extensions for Outlook. Contact your system administrator for more information.




	
Note:

The steps provided below are for users of Outlook 2010 with Windows 7. For other versions of Outlook, refer to Microsoft Outlook's documentation.








To configure Microsoft Outlook to connect to Oracle Beehive:

	
From the Start menu, click Control Panel.


	
Select User Account, and then click on the Mail icon.


	
On the Mail Setup dialog box, select the Add button.


	
The New Profile dialog box will be displayed. Type the new profile name and click OK.


	
In the Add New Accounts dialog box, select the Manually configure server settings or additional server types option and click Next.


	
Select Internet E-mail and click Next.


	
From the Account Type list, select IMAP.


	
Enter your incoming and outgoing mail servers.


	
Enter your user name and password.


	
Click More Settings.


	
Click the Advanced tab.


	
Enter port numbers for your incoming and outgoing mail servers. Click OK.


	
Click Next.


	
Click Finish









Mozilla Thunderbird

Versions: Mozilla Thunderbird 3.1, 5, 6, 17.0.2 ESR

Operating Systems: Microsoft Windows XP, 7, and 8; Linux, and Mac OS

This section describes how to connect to Oracle Beehive's IMAP and SMTP services using Mozilla Thunderbird.




	
Note:

The steps provided below are for users of Thunderbird 6 with Windows 7. For other versions of Thunderbird, refer to Mozilla Thunderbird's documentation.








To configure Mozilla Thunderbird to connect to Oracle Beehive:

	
From the New Account Setup dialog box, select Email account, and click Next.


	
Enter your name and e-mail address, and click Next.


	
Select IMAP, enter the name of your incoming mail server, and click Next.


	
Enter your user name and click Next.


	
Enter a name for your account and click Next.


	
Verify that all your information is accurate. If you want to edit your account information, click Back. Otherwise, click Finish to create your account.


	
From the Tools menu, select Account Settings.


	
Select Server Settings from the list on the left-hand side. Enter a port number for your incoming mail server.


	
Select Outgoing Server (SMTP) from the list on the left-hand side. Select your server and click Edit.


	
Enter a port number for your outgoing mail server and click OK.


	
Click OK to save your account settings.










Managing Calendar and Task List

This section provides configuration instructions for the following clients:

	
Apple iCal


	
Mozilla Lightning




In addition to providing configuration instructions, this section also contains the following topics:

	
CalDAV Quick Tips and Help Topics


	
Troubleshooting Issues with Supported CalDAV Clients and Oracle Beehive


	
Known Limitations with Supported CalDAV Clients and Oracle Beehive






Apple iCal

Versions: Apple iCal 4, 5, 6

Operating Systems: Mac OS X 10.6, 10.7, 10.8

This section describes how to connect to Oracle Beehive's CalDAV service using Apple iCal.




	
Note:

The steps provided below are for users of Apple iCal 5 with Mac OS X 10.7. For other versions of iCal, refer to Apple iCal's documentation.








Configuring Apple iCal 5.0 to Connect to Oracle Beehive

To configure Apple iCal 5.0 to connect to Oracle Beehive:

	
Verify that Apple iCal 5.0 is running on your computer.


	
Open a Web browser and enter the location for Oracle Beehive CalDAV Companion Web Access using the following structure:

https://<Server-Name>:<Port-Number>/caldav




	
Example:

Your server name is server.example.com and your port number is 5555, so the URL you enter is: https://server.example.com:5555/caldav.
For more information on client URLs, refer to Accessing Calendars of Other Users, Resources, and Team Workspaces.









If you do not know the Oracle Beehive CalDAV Companion Web Access URL, contact your system administrator.


	
Enter your Oracle Beehive user name and password. Click OK.


	
Click the Help link in the top right-hand corner of the window.


	
In the Configuring Apple iCal 5.0 section (in the CalDAV Companion Web Access page), copy the URL next to Server Address.


	
Switch to iCal.


	
From the iCal menu, select Preferences.


	
Click the Accounts tab.


	
Click + to add an account.


	
Select Account Type: CalDAV.


	
Enter your Oracle Beehive user name and password.


	
In the Server Address field, paste the URL you copied in step 5.


	
Click Create and wait while the initial synchronization takes place.


	
Close the Accounts window. Your Oracle Beehive calendar is now listed as Default Calendar under the account description heading in the left-hand column.











Mozilla Lightning

Versions: Thunderbird 3.1 with lightning 0.9b, Thunderbird 5.0 with lightning 1.0b4, Thunderbird 6.0 with Lightning 1.0b5, and Thunderbird 17.0.2 ESR with Lightning 1.9.

Operating Systems: Microsoft Windows XP, 7 and 8; Linux; and Mac OS

This section describes how to connect to Oracle Beehive's CalDAV Service using Mozilla Lightning which is an add-on to Mozilla Thunderbird.


Configuring Mozilla Lightning to Connect to Oracle Beehive

To configure Mozilla Lightning to connect to Oracle Beehive:

	
Verify that Mozilla Thunderbird is running on your computer and that you have installed the Lightning add-on.


	
Open a Web browser and enter the location for Oracle Beehive CalDAV Companion Web Access using the following structure:

https://<Server-Name>:<Port-Number>/caldav




	
Example:

Your server name is server.example.com and your port number is 5555, so the URL you enter is https://server.example.com:5555/caldav.
For more information on client URLs, refer to Accessing Calendars of Other Users, Resources, and Team Workspaces.









If you do not know the Oracle Beehive CalDAV Companion Web Access URL, contact your system administrator.


	
Enter your Oracle Beehive user name and password. Click OK.


	
Click the Help link in the top right-hand corner of the window.


	
In the Configuring Mozilla Lightning section, copy the URL next to Location.


	
Switch to Mozilla Thunderbird.


	
Click the Calendars tab.


	
On the menu, click Calendar and then click New Calendar. The Create New Calendar window opens.


	
Select On the Network and click Next.


	
In the Format list, select CalDAV.


	
In the Location box, paste the location of your Oracle Beehive calendar (the URL that you copied in Step #5).


	
Click Next.


	
Enter a calendar name, choose a display color for your calendar entries, and click Next.


	
Enter your user name and password, and click OK.


	
Click Finish. You are now subscribed to your Oracle Beehive calendar. It may take a few seconds for Lightning to retrieve the contents of your calendar from the server.











CalDAV Quick Tips and Help Topics

This section contains the following additional tips and help topics related to CalDAV clients:

	
Accessing Calendars of Other Users, Resources, and Team Workspaces


	
Scheduling Users, Groups, and Team Workspaces


	
Scheduling an Online Conference






Accessing Calendars of Other Users, Resources, and Team Workspaces

To access the calendar of another user, resource, or team workspace (using Apple iCal or Mozilla Lightning), follow the configuration steps described in the previous section. The e-mail address of the user, resource or team workspace that you want to access must be specified in the calendar or account address.




	
Note:

Your organization's format may vary. For example, the port number may not be always required. The URL format is specific to organizations.
Check with your system administrator for the specific URL/format used in your organization for each CalDAV client.









Examples of calendar or account address formats that may be used with each supported CalDAV client:


	Entity	Format
	Apple iCal	https://<Server-Name>:<Port-Number>/caldav/<Company-Name>/principals/individuals/<E-mail address>/calendars/MyCalendar
	Mozilla Lightning	https://<Server-Name>:<Port-Number>/caldav/<Company-Name>/home/<E-mail address>/calendars/MyCalendar










Scheduling Users, Groups, and Team Workspaces

To schedule meetings and tasks with other users, resources, groups, and team workspaces, add them as attendees by entering their e-mail address. The server will deliver a meeting invitation or task assignment to all specified attendees.

Users, resources, groups, and team workspaces that have not been assigned an e-mail address can be invited to meetings and assigned tasks by specifying the appropriate prefix followed by the name.

For example:


	Attendee Type	Prefix	Example
	User	user=	user=John~Smith
	Resource	resource=	resource=Room~101
	Workspace	workspace=	workspace=Project~Z
	Group	group=	group=Project~Z.Participants
	Group Members	members=	members=Project~Z.Participants









	
Note:

Use a tilde (~) to represent a space in any name.












Scheduling an Online Conference

To schedule an online conference for a meeting, add the Beehive Conferencing resource as an attendee. The Beehive Conferencing resource can be invited by entering the e-mail address: onlineconference








Troubleshooting Issues with Supported CalDAV Clients and Oracle Beehive

This section provides troubleshooting tips for issues that might arise when using a supported CalDAV client with Oracle Beehive. This section contains the following topics:

	
About Time Zone Settings and Oracle Beehive


	
Error Messages in Mozilla Lightning


	
Creating Events in Mozilla Lightning






About Time Zone Settings and Oracle Beehive

Make sure you select the appropriate time zone for your location before you begin working with your Oracle Beehive calendar. Otherwise, your calendar events may not appear at the right times.






Error Messages in Mozilla Lightning

Occasionally, you may encounter the following error message: "The calendar <Your-Calendar-Name> is momentarily not available.” This message typically occurs if you have entered a wrong calendar URL. Verify your calendar URL with your system administrator.






Creating Events in Mozilla Lightning

If an event you have created does not appear in your Oracle Beehive calendar, make sure that you have not accidentally created the event in your local calendar instead.








Known Limitations with Supported CalDAV Clients and Oracle Beehive

The following are known limitations of using supported CalDAV clients with Oracle Beehive:

	
Oracle Beehive returns events from the previous week through two years into the future, up to a maximum of 250 events. Events from earlier time periods are returned if less than 250 events are found.


	
When you create a meeting in a team workspace, all team workspace members are invited by default.


	
Oracle Beehive does not support the following Apple iCal features:

	
External attachments


	
Delegation


	
Managing available hours





	
iCalendar categories do not map to Oracle Beehive tags.











Using Instant Messaging

This section provides configuration instructions for the following instant messaging (IM) clients:

	
Apple iChat


	
Pidgin


	
Trillian Pro




In addition to providing configuration instructions, this section also contains the following topics:

	
Troubleshooting Tips for Supported Instant Messaging Clients with Oracle Beehive


	
Known Limitations of Supported Instant Messaging Clients with Oracle Beehive






Apple iChat

Versions: Apple iChat 5, 6

Operating System: Mac OS X 10.6, 10.7, 10.8

This section describes how to connect to Oracle Beehive's XMPP service using Apple iChat.




	
Note:

The steps provided below are for users of Apple iChat 5 with Mac OS X 10.7. For other versions of Apple iChat, refer to Apple iChat's documentation.








To configure Apple iChat to connect to Oracle Beehive:

	
From the iChat menu, select Preferences.


	
Click + to create an account. The Account Setup window opens.


	
In the Account Type list, select Jabber Account.


	
In the Account Name and Password boxes, enter your e-mail address and password.


	
Click Server Options.


	
In the Server and Port boxes, enter the server and port number for your Jabber server. If you do not know your port number, contact your system administrator.


	
Optionally, enable SSL connections by clicking the Use SSL check box so that a check mark appears. If you are unsure of whether or not to enable SSL, contact your system administrator.


	
Click Done.


	
From the iChat menu, select Log In to Jabber.









Pidgin

Versions: Pidgin 2.10.x

Operating Systems: Microsoft Windows XP and 7, Linux

This section describes how to connect to Oracle Beehive's XMPP service using Pidgin.




	
Note:

The steps provided are for Pidgin 2.10 on Windows 7. For other versions of Pidgin, refer to Pidgin's documentation.








To configure Pidgin to connect to Oracle Beehive:

	
On the Pidgin menu bar, click Accounts and then click either Add/Edit or Manage Accounts, depending on your version. The Accounts window opens.


	
Click Add.


	
On the Basic tab, choose XMPP from the Protocol list.


	
In the Screen Name box, enter your username. For example, if your e-mail address is abc.def@example.com, then would enter abc.def as your username. If you do not know your username, contact your system administrator.


	
In the Domain field, enter your domain name. For example, if your e-mail address is abc.def@example.com, then you would enter example.com as your domain name. If you do not know your domain name, contact your system administrator.


	
Click the Advanced tab.


	
In the Connect Server box, enter the full name of your server. Your server name may be different than your domain name. For example, if your server name is server.example.com, you would enter server.example.com. If you do not know your server name, contact your system administrator.




	
Note:

Other options provided on the Advanced tab allow you to change your connection type and settings. The typical connection uses SSL/TLS and port 5222. Only change these settings if your system administrator instructs you to do so.








	
Click Save.









Trillian Pro

Operating System: Microsoft Windows XP


To configure Trillian Pro to connect to Oracle Beehive:

	
From the Trillian menu, select Trillian Preferences.


	
Click Plugins.


	
Select the Jabber check box.


	
Click Identities & Connections in the list on the left side.


	
Select an identity and click Add a new connection. Select Jabber from the list.


	
In the JID field, enter your user name and your XMPP domain name using the <User-Name>@<Domain-Name> structure. For example, if your user name is jcoetzee and your XMPP domain name is acme.com, you enter: jcoetzee@acme.com in the JID field.


	
Enter your password.


	
Click Change.


	
On the Connection tab, enter your server host and port number. If you do not know your Oracle Beehive server host and port number, contact your system administrator.


	
Optionally, click the Use legacy SSL connection check box so that a check mark appears.


	
Click Save Settings.


	
Click Connect.









Troubleshooting Tips for Supported Instant Messaging Clients with Oracle Beehive

This section provides troubleshooting tips for issues that might arise when using a supported instant messaging client with Oracle Beehive. Where possible, workarounds for these issues are provided. This section contains the following topics:

	
I sent an instant message to someone who was offline and the message wasn't delivered when the person logged back into Oracle Beehive


	
I didn't receive an instant message that was sent to me while I was offline






I sent an instant message to someone who was offline and the message wasn't delivered when the person logged back into Oracle Beehive

Log out of Oracle Beehive through your Instant Messaging client and then log back in. The message should now appear in the message queue for the user's Instant Messaging client, or wherever offline messages are displayed. For more information, refer to Instant Messages Sent to Offline Users Might not be Delivered Immediately.






I didn't receive an instant message that was sent to me while I was offline

Log out of Oracle Beehive through your Instant Messaging client and then log back in. The message should now appear in the message queue for your Instant Messaging client, or wherever offline messages are displayed. For more information, refer to Instant Messages Sent to Offline Users Might not be Delivered Immediately.








Known Limitations of Supported Instant Messaging Clients with Oracle Beehive

This section provides information on the known limitations of using supported instant messaging clients with Oracle Beehive. Where possible, workarounds for these limitations are provided. This section contains the following topics:

	
Oracle Beehive Does Not Support Secure File Transfers Through Instant Messaging


	
Instant Messages Sent to Offline Users Might not be Delivered Immediately






Oracle Beehive Does Not Support Secure File Transfers Through Instant Messaging

You cannot transfer files securely when using an instant messaging client with Oracle Beehive. Though your SSL connection to the server is secure, files will be not securely transferred. When you attempt to transfer a file, you will be warned that the file transfer will be not be secure. You can then proceed with the non-secure file transfer or cancel the operation.






Instant Messages Sent to Offline Users Might not be Delivered Immediately

If you receive an Instant Message while you are offline, Oracle Beehive stores that message for later delivery. In some cases, there may be a brief delay delivering the message when you log back in to the system. As a result, the message may not be delivered to you during the current session, particularly if you log in within a minute of the message being sent and your session is brief. If this occurs, log out of the system and log back in. The message should appear in the message queue for your Instant Messaging client, or wherever your offline messages are displayed.










Accessing Documents (Web Clients and FTP Clients)

This section provides configuration instructions for the following WebDAV and FTP clients:

	
Browser-based Access


	
Desktop WebDAV Clients


	
Desktop FTP Clients




In addition to providing configuration instructions, this section also contains the following topics:

	
Troubleshooting Tips for Supported WebDAV Clients with Oracle Beehive


	
Known Issues of Supported WebDAV Clients with Oracle Beehive






Browser-based Access

Browser Versions: Internet Explorer 7, 8, 9, 10; Firefox 3, 4, 5, 6, 17.0.2 ESR; Safari 4, 5

This section describes how to access documents using Oracle Beehive's WebDAV service through your favorite browser.

This section contains the following topics:

	
How do I connect to Oracle Beehive's WebDAV service from my browser?


	
How do I log out of Oracle Beehive's WebDAV service from my browser?


	
How do I access folder names that contain symbols from my browser?






How do I connect to Oracle Beehive's WebDAV service from my browser?

To connect to Oracle Beehive's WebDAV service:

	
In the Address field, enter the URL to connect to Oracle Beehive using the following structure:

https://<Server-Name>:<Port-Number>/content/dav




	
Example:

Your server name is server.example.com and your port number is 5555, so the URL you enter is https://server.example.com:5555/content/dav.







If you do not know your Oracle Beehive URL, contact your system administrator.


	
Enter your user name and password, and click OK.









How do I log out of Oracle Beehive's WebDAV service from my browser?

To log out of Oracle Beehive's WebDAV service, click the Logout link in the top right-hand corner of the page.






How do I access folder names that contain symbols from my browser?

If you create a folder with a name that contains symbols from your browser, you may not be able to access the folder in your browser by clicking the folder link in your personal workspace. To access the folder in your browser, copy the address from your Web Folder and paste it in the browser's Address field.








Desktop WebDAV Clients

This section provides configuration instructions for the following desktop WebDAV clients:

	
Mac OS X Finder Web Access


	
Cadaver


	
Microsoft Windows Web Folders






Mac OS X Finder Web Access

Operating System: Mac OS X 10.6 and 10.7




	
Note:

Mac OS 10.8 is not supported due to a bug introduced by Apple. The bug that was reported to Apple is, Bug ID# 12421095.







This section contains the following topics on Mac OS X Finder Web Access:

	
How do I configure Mac OS X Finder Web Access to connect to Oracle Beehive?


	
WebDAV Server Behavior in Mac OS X







	
Note:

The steps provided are for Mac OS X Finder Web Access on Mac 10.7. For other versions of Finder Web Access, refer to Finder Web Access's documentation.









How do I configure Mac OS X Finder Web Access to connect to Oracle Beehive?

To configure Mac OS X Finder Web Access to connect to Oracle Beehive:

	
From the Go menu, select Connect to Server.


	
In the Server Address field, enter the URL to connect to Oracle Beehive using the following structure:

https://<Server-Name>:<Port-Number>/content/dav




	
Example:

Your server name is server.example.com and your port number is 5555, so the URL you enter is https://server.example.com:5555/content/dav.







If you do not know your Oracle Beehive URL, contact your system administrator.


	
Click Connect.


	
Enter your user name and password and click OK.









WebDAV Server Behavior in Mac OS X

When right-clicking a folder or document on a WebDAV server, the following Mac OS X options will not work:

	
Make Alias


	
Create Archive




If you want to reduce the number of files sent from your desktop to the Oracle Beehive WebDAV server, you can disable the creation of .DS_Store files on your Macintosh computer using instructions found at the following location: http://docs.info.apple.com/article.html?artnum=301711

However, disabling the creation of .DS_Store files on your Macintosh computer will prevent you from copying files from a local file system to the Oracle Beehive WebDAV server. All other WebDAV operations should function normally.








Cadaver

Operating System: Linux

This section contains the following topics on Cadaver:

	
How do I configure Cadaver to connect to Oracle Beehive?


	
What are the known limitations of Cadaver?







	
Note:

The steps provided are for Cadaver. For other versions of Cadaver, refer to software's documentation.









How do I configure Cadaver to connect to Oracle Beehive?

To configure Cadaver to connect to Oracle Beehive:

	
Open a shell.


	
Execute the cadaver command: https://<Server-Name>:<Port-Number>/content/dav

For example, if your server name is server.example.com and your port number is 5555, your command would be:

cadaver https://server.example.com:5555/content/dav


	
Enter your user name and password.









What are the known limitations of Cadaver?

Cadaver only supports alphanumeric characters and spaces in file and folder names. Therefore, if you attempt to open, copy, or move a file and folder that contains a non-alphanumeric character in its name, you will receive the following error message:

405 Method Not Allowed

To avoid this error message, only work with files and folders that contain alphanumeric characters and spaces.

Non-alphanumeric characters that Cadaver does not support include the following:

& # \ / : * ? < > | + { } ^ [ ] ( ) ` _








Microsoft Windows Web Folders

Operating Systems: Microsoft Windows XP, 7, and 8

This section contains the following topics about Microsoft Windows Web Folders:

	
Configuring Microsoft Windows Web Folders to Connect to Oracle Beehive


	
Logging Out of Oracle Beehive from Microsoft Windows Web Folders


	
Web Folders Versions Supported by Oracle Beehive


	
Known Limitations of Using Microsoft Windows Web Folders with Oracle Beehive






Configuring Microsoft Windows Web Folders to Connect to Oracle Beehive

To configure Microsoft Windows Web folders to connect to Oracle Beehive:

	
In Windows Explorer, click My Network Places.


	
Click Add a network place.


	
Click Next.


	
Select Choose another network location and click Next.


	
In the Internet or network address field, enter the URL to connect to Oracle Beehive using the following structure:

https://<Server-Name>:<Port-Number>/content/dav




	
Example:

Your server name is server.example.com and your port number is 5555, so the URL you enter is https://server.example.com:5555/content/dav.







If you do not know your Oracle Beehive URL, contact your system administrator.


	
Enter your user name and password, and click OK.


	
Enter a name for your network place, and click Next.


	
If you want to access this network place immediately, select the Open this network place when I click Finish check box.


	
Click Finish.









Logging Out of Oracle Beehive from Microsoft Windows Web Folders

Microsoft Windows Web Folders does not provide an explicit logout function. To log out of an Oracle Beehive-based Web Folder, you can do one of the following:

	
Log out of your Windows session: To use this method, log out of your current Windows user session from the Windows Start menu.


	
Log out of your WebDAV session and delete the Network Place that's mapped to Oracle Beehive: To use this method, open Microsoft Internet Explorer, enter the WebDAV URL for Oracle Beehive in your Address bar (typically https://<server_name>:<port_number>/content/dav), and, once the page opens, click Logout in the top-right corner of the page. Then, in Windows Explorer, access My Network Places and delete the Network Place that's mapped to Oracle Beehive. (You'll need to recreate this Network Place the next time you want to access it.)









Web Folders Versions Supported by Oracle Beehive

Oracle Beehive supports the following versions of Microsoft Windows Web Folders:

	
11.0.6715.60 or later


	
12.0.4518.1014 or later









Known Limitations of Using Microsoft Windows Web Folders with Oracle Beehive

This section provides information on the known limitations of using Microsoft Windows Web Folders with Oracle Beehive. Where possible, workarounds for these limitations are provided. This section contains the following topics:

	
Microsoft Windows XP Professional 2002 Service Pack 2: When you create a folder in your personal workspace, you may receive an error message stating that an entity was not found. Ignore the error. The folder will be created normally.


	
Web Folders 12.0.4518.1014:

	
Opening a text file will generate an error message stating that the file name, directory name, or volume label syntax is incorrect. Ignore the error.


	
Moving or copying a file to a directory where a file with the same name exists will fail.





	
Explicit file versioning not supported in Manual mode: Microsoft Windows Web Folders does not support explicit versioning of files when versioning control is set to Manual mode. To update a file hosted by Web Folders when versioning is set to Manual mode, users must check out a file, change it, save it, and check it back in.


	
"Save Link As" option does not work on Mozilla Firefox 3.0.7 if third-party cookies blocked: Using the Save Link As option (on the right-click menu) to download files through Microsoft Windows Web Folders will not work if Firefox 3.0.7 is configured to block third-party cookies. Instead of downloading the intended file to your computer, Firefox downloads a generic HTML file.

To avoid this issue, do one of the following:

	
Use another method to download the file, such as clicking the file's link using the left mouse button.


	
Configure Firefox to accept third-party cookies. For more information, refer to the documentation provided with your copy of Mozilla Firefox.




For more information, refer to the entry for this issue in the Mozilla Foundation's bug database: http://bugzilla.mozilla.org/show_bug.cgi?id=464404











Troubleshooting Tips for Supported WebDAV Clients with Oracle Beehive

This section provides troubleshooting tips for issues that might arise when using a supported WebDAV clients with Oracle Beehive. Where possible, workarounds for these issues are provided. This section contains the following topics:

	
While connecting to WebDAV through Web Folders, the Login prompt keeps appearing


	
The folder I created through WebDAV folders doesn't show, even though it says it exists


	
After copying a file from one folder to another within WebDAV Folders, it shows the file size at 0 bytes


	
I clicked to open a .jpg file, but the MS Picture Viewer doesn't show the image


	
I am prompted to log in to WebDAV again, even though I was already logged in


	
I am prompted to log in to access a document through Internet Explorer, even though I am not logged in Web Folders


	
I am prompted to log in again after I opened a Microsoft Office document online then closed in the browser


	
I wasn't prompted to log in to Internet Explorer again after leaving idle, even though I did work in WebDAV and had access to Web Folders


	
I wasn't prompted to log in to Internet Explorer again after leaving idle, even though I did work in WebDAV and had access to Web Folders


	
I uploaded a document with a non-English name [or contents], but the name [or contents] appears unreadable


	
My Web Folder was working, but now DAV operations don't complete, and I can't access the server


	
I use Windows 7 and I have issues connecting to the WebDAV server


	
Unable to edit an Office 2013 document from the Beehive Team Collaborstion client in Internet Explorer






While connecting to WebDAV through Web Folders, the Login prompt keeps appearing

While attempting to connect to WebDAV using Web Folders, the login prompt may continue to appear. If this occurs, try connecting to the WebDAV server through a secure connection. Enter the following URL: https://<Server-Name>/content/dav where: <Server-Name> is your company's beehive server.

If this does not resolve the issue, try manually configuring the Web Client service (without specifying a port) by following the steps below:


To configure the Web Client service:

	
On your Windows machine, stop the Web Client service by navigating to:

Start > Control Panel > Administrative Tools > Services


	
Select Web Client and stop the service.


	
For "Startup Type" of the Web Client service, select Manual.


	
Set up the Web Folder with the following URL:

https://<Server-Name>/content/dav(Do not specify a port.)









The folder I created through WebDAV folders doesn't show, even though it says it exists

If you created a new folder using WebDAV folders, but the folder does not appear even after you try to recreate it, you may see a message indicating the folder already exists. To resolve the issue, try manually configuring the Web Client server (without specifying a port).


To configure the Web Client service:

	
On your Windows machine, stop the Web Client service by navigating to:

Start > Control Panel > Administrative Tools > Services


	
Select Web Client and stop the service.


	
For "Startup Type" of the Web Client service, select Manual.


	
Set up the Web Folder with the following URL:

https://<Server-Name>/content/dav(Do not specify a port.)









After copying a file from one folder to another within WebDAV Folders, it shows the file size at 0 bytes

Files copied from one WebDAV folder to another may result in the file size appearing as "0 bytes". This is a known issue with the Web Folders client. After the copy/move operation, it does not attempt to obtain the details of the newly copied/moved file. As a workaround, refresh your folder (select View > Refresh, or press F5) and the correct file size should appear.






I clicked to open a .jpg file, but the MS Picture Viewer doesn't show the image

Images in the .jpg format that are clicked to be opened from WebDAV Folders, opens the Microsoft Picture Viewer application, but are not displayed. This is due to the Microsoft Picture Viewer application not being enabled for WebDAV. As an alternative, try opening the image file in Internet Explorer.






I am prompted to log in to WebDAV again, even though I was already logged in

If you leave WebDAV open in your browser running idle after an hour or more, your WebDAV session will time out. After it times out, you will need to log in again--even after opening and logging in to WebDAV the first time, and after performing some operations. Enter your username and password to log back in.






I am prompted to log in to access a document through Internet Explorer, even though I am not logged in Web Folders

Even when you are not logged in to Web Folders, and you open Internet Explorer to click on a Microsoft Office document (such as Word, or Excel) you may be prompted to enter your user information. If this is the case, you can bypass the login by opening the Microsoft document online in Internet Explorer. The steps required for configuration are available at:

http://support.microsoft.com/kb/162059






I am prompted to log in again after I opened a Microsoft Office document online then closed in the browser

If you clicked "Back" on your Web browser window, or closed the browser after opening a Microsoft Office document, you are prompted to enter your user information again.

or close the web browser window. I am prompted to enter credentials again. If this is the case, you can bypass the login by opening the Microsoft document online in Internet Explorer. The steps required for configuration are available at:

http://support.microsoft.com/kb/822128






I wasn't prompted to log in to Internet Explorer again after leaving idle, even though I did work in WebDAV and had access to Web Folders

If you were working in WebDAV, then opened Internet Explorer to access Web Folders and left the browser idle, Internet Explorer does not prompt you for your username and password again. This is because sessions involving non-browser WebDAV clients, (such as Web Folders) are intended to last longer. (Default time-out is 16 hours). Since the operation last performed before idle used Web Folders, your WebDAV session has been extended.






I uploaded a document with a non-English name [or contents], but the name [or contents] appears unreadable

A document file name, or contents which are in a language other than English may appear unreadable after uploading. This is because your WebDAV client is not sending the encoding information correctly. To resolve the issue, try setting your "Content" user preferences ("document_uri_encoding", "document_character_encoding") to the encoding used by your WebDAV client.






My Web Folder was working, but now DAV operations don't complete, and I can't access the server

If you can no longer access the beehive server, try deleting the mapped network location and re-map. If this does not resolve the issue, and the WebDAV server is bounced, it is most likely that your DAV cookie on the client is not expired. If this does not correct the issue, delete all cookies in your Internet Explorer browser. Go to Tools > Internet Options > Delete > Delete cookies and try reconnecting.






I use Windows 7 and I have issues connecting to the WebDAV server

If you use Windows 7, follow the steps mentioned below to connect to the WebDAV server.

Apply the Microsoft Webfolders patch KB907306 before connecting to WebDAV server from the following link, it is a one-time procedure.

http://www.microsoft.com/downloads/details.aspx?FamilyId=17C36612-632E-4C04-9382-987622ED1D64&displaylang=en)

After applying the patch, follow the steps below to connect to the WebDAV server:

	
From the Start menu, select Computer.


	
From the top Menu bar, select Map network drive.


	
On the Map network drive interface, select the option Connect to a web site that you can use to store your documents and pictures. Add Network Location interface appears.


	
On the Add Network Location interface, click Next to proceed.


	
Select the option No, create a new connection.


	
Enter the WebDAV server url in the address box. For example: http://host:port/content/dav


	
Enter the credentials and click Next. It will create the network place.


	
Again, click Start menu and select Computer. On the top Menu bar, select Map network drive.


	
Enter the WebDAV url directly in the dialog's Folder text box in the format as mentioned below (without http):

\\host:port\content\dav


	
Click Finish.

No credentials are needed. Note the Drive value that you chose in the dialog box.

This creates another network location which has the drive name and the associated url in the format \\host:port\content\dav. Use this network location only for your WebDAV operations.









Unable to edit an Office 2013 document from the Beehive Team Collaborstion client in Internet Explorer

The ability to edit a file directly using Office 2013 from the Beehive Team Collaborstion client in Internet Explorer is possible only if both Internet Explorer and Office are both 32 bit.








Known Issues of Supported WebDAV Clients with Oracle Beehive

This section provides information on the known issues using supported WebDAV clients with Oracle Beehive. Where possible, workarounds for these issues are provided. This section contains the following topics:

	
Broken Network Connection in Microsoft Windows 7


	
Software Update on Microsoft Windows Vista


	
No Support for Non-ASCII Username/Password


	
A Common Error Message Appears, Without Specifying a Single Error


	
Copying/Moving Files or Folders Fails for Filenames Containing Spaces


	
Unable to Select "Lock" on a Document in WebDAV Folders


	
Older Versions of Windows Web Folders Cache User Credentials


	
Errors Result When Accessing or Viewing WebDAV Clients Through Different Browser Operations


	
Uploading Multi-Byte Named File Using WebDAV to a Workspace Leaves the File Corrupt or Missing






Broken Network Connection in Microsoft Windows 7

12364768 - WebDAV connection broken on Windows 7, after rebooting. A Microsoft KB article 841215 describes the issue. The workaround involves setting a registry entry. However, even with the registry setting, there seems to be a limitation whereby the "Add a network place" procedure only works for WebDAV servers using default ports.

After logging out or rebooting your computer, the newly added network place no longer works. You may have to delete it and re-create it.

Workaround: In order to solve the issue, you may need to modify Windows 7 configuration.

	
Click Start and type secpol.msc in the search function. The system displays the Local Security Policy interface.


	
Select Local Policies, and then Security Options.


	
In the Security Options, look for the entry Network Security: LAN Manager authentication level and open it.


	
From the Network Security: LAN Manager authentication level dropdown menu, select the option Send LM & NTLM - use NTLMv2 session security if negotiated.


	
Apply the settings.


	
Open Services (Windows/system32/Services.msc), change WebClient startup type to Automatic.


	
Reboot the machine.




For more information, refer to the following link: http://download.oracle.com/docs/cd/E16671_01/bh.200/e16640/services_notes.htm#CHDCFFHD.

12419122 - Problem accessing MS Office 2003 docs using Beehive WebDAV on Windows 7. This is Microsoft issue and their recommendation is to upgrade Office version.

Workaround is to access the WebDAV URL using browser to open the MS Office 2003 document. Or you may copy the Microsoft Office file from network location to local machine and then open it.






Software Update on Microsoft Windows Vista

You may need to apply Microsoft software update for Web Folders (KB907306) to have them work correctly.






No Support for Non-ASCII Username/Password

Bug 8212373. There is no support for username and/or passwords entered in a non-ASCII format. Windows Vista Web Folder is not supported. Navigation through browser into URLs containing characters [or] may result in an error.






A Common Error Message Appears, Without Specifying a Single Error

Bug 8212373. A common error dialog may appear for all error scenarios. Windows Web Folders does not select the message sent by the WebDAV server. For example, if you create, update, or delete a document and send it through a workflow process, Web Folders cannot interpret the response status code correctly. As a result, Windows Web Folders returns an error.






Copying/Moving Files or Folders Fails for Filenames Containing Spaces

Bug 8212373. In Cadaver, when copying or moving files that contain spaces in the file name fails, it is most likely due to an older version of Cadaver being used, which contain encoding issues. As a workaround, use Cadaver version 0.22.5 or later.






Unable to Select "Lock" on a Document in WebDAV Folders

Bug 8212373. A document uploaded to the Documents folder in a personal workspace, may not allow users to select the "Lock" option, when document information is access from WebDAV Folders. After selecting the "Lock" check box, it may immediately be deselected. This is because the WebDAV client does not send a WebDAV lock request.






Older Versions of Windows Web Folders Cache User Credentials

Bugs 8435621 and 8406741. Older versions of Microsoft Windows Web Folders (msdaipp.dll version 12 or earlier) cache users' authentication credentials after successful connections. As a result, these Web Folders sessions may last longer than the limit specified by the session time-out setting (DavClientSessionTimeout) for the Oracle Beehive WebDAV Service.






Errors Result When Accessing or Viewing WebDAV Clients Through Different Browser Operations

Bug 8428117. An internal server error occurs when logging in to WebDAV by opening an additional tab in your browser, then logging out of sites through the tabs. Clicking any of the links in the WebDAV tab open in the browser causes the error. As a workaround to access WebDAV, close the browser window, then open a new browser window and log in to WebDAV.Another error occurs when WebDAV has been open in the browser and left idle for more than approximately 15 minutes. When attempting to perform any operation, user information may not appear. Try performing another operation. The user information should reappear correctly. Resume viewing information on WebDAV as normal.






Uploading Multi-Byte Named File Using WebDAV to a Workspace Leaves the File Corrupt or Missing

Bug 7386319. Files are either corrupt or missing when attempting to upload a file with a name in a multi-byte language (such as Chinese, Korean, Japanese) to a workspace using WebDAV. As a result, multi-byte characters are not be displayed correctly, or the file will be missing. This can occur if the user's system configuration uses an older version of WebDAV. If the user's version is older than Web Folder 8.103.5219.0, the software must be updated, or the latest patch must be installed on the user's system.

If you do not have the Web Folders patch installed, the non-ASCII date uploaded to the WebDAV workspace will become corrupt or missing.

For users running an older version (than 8.103.5219.0), follow the steps below to download the necessary patch to resolve this issue.

To download the WebDAV patch for multi-byte language issues:

	
Download and install the Webfldrs-KB907306-ENU.exe patch available on the Microsoft Download Center:

http://support.microsoft.com/kb/892211







	
Note:

Check with your system administrator for more information or assistance with installing the patch and/or updating WebDAV Folders on your system.
















Desktop FTP Clients

This section provides configuration instructions for the following desktop FTP clients:

	
FileZilla


	
NCFTP


	
SmartFTP


	
Transmit






FileZilla

Versions: 3.x

Operating System: Microsoft Windows XP

This section contains the following topics on FileZilla:

	
How do I configure FileZilla 3.x to connect to Oracle Beehive?


	
Known Issues with Windows Character Sets and Uploading with FileZilla 3.x






How do I configure FileZilla 3.x to connect to Oracle Beehive?

To configure FileZilla 3.x to connect to Oracle Beehive:

	
From the File menu, select Site Manager.


	
Click New Site.


	
Enter a name for the site.


	
In the Host field, enter your server name (e.g. myserver.oracle.com).


	
Enter your port number.


	
From the Servertype list, select FTP.


	
In the Logontype section, select the Normal check box.


	
Enter your user name and password.


	
Click Connect.


	
Click Save and Exit.









Known Issues with Windows Character Sets and Uploading with FileZilla 3.x

Uploading a file to a directory using the Windows-1252 user character set and a non-English language will fail. Issue with 2.x, need to confirm if also with 3.x








NCFTP

Versions: NCFTP 3.2.6

Operating System: Linux


How do I configure NCFTP to connect to Oracle Beehive?

To configure NCFTP to connect to Oracle Beehive:

	
Launch NCFTP.


	
Connect to the Oracle Beehive server using the open command with the -u (user name) and -P (port number) options and arguments. For example, if your user name, port number, and server name were jcoetzee, 7777, and server.example.com, respectively, you would type open -u jcoetzee -P 7777 server.example.com.


	
For more information, consult the NCFTP documentation.









SmartFTP

Versions: Smart FTP 2.5.0

Operating System: Microsoft Windows XP


How do I configure SmartFTP to connect to Oracle Beehive?

To configure SmartFTP to connect to Oracle Beehive:

	
From the File menu, select New Remote Browser.


	
Select Normal FTP from the Protocol list.


	
In the Host field, enter the name of your server. For example, if your server name is server.example.com, you would enter server.example.com in the Host field. If you do not know your server name, contact your system administrator.


	
Enter the port number of your server in the Port field.


	
Select Username and Password from the Login Type list.


	
Enter your user name and password.


	
Click OK.









Transmit

Versions: Transmit 3.5.0

Operating System: Mac OS X 10.6 and 10.7


How do I configure Transmit to connect to Oracle Beehive?

To configure Transmit to connect to Oracle Beehive:

	
In the Server field, enter the server name. For example, if your server name is server.example.com, you would enter server.example.com in the Server field. If you do not know your server name, contact your system administrator.


	
Enter your user name and password.


	
Enter the port number of your server.


	
Select FTP from the Protocol list.


	
Click Connect.








What are the known limitations of using Transmit 3.5.0 with Oracle Beehive?

The following are the known limitations of using Transmit 3.5.0 with Oracle Beehive:

	
Copying Document Aliases: When you transfer a document alias, Transmit will transfer the original document, not the alias.















RSS Clients

From the Oracle Beehive Team Collaboration client, users will see an RSS icon in the top right corner of pages that support RSS feeds. Certified RSS readers include:

	
Mozilla Thunderbird


	
FireFox Live Bookmarks


	
Omea


	
Sharp Reader


	
Feed Demon


	
NewzCrawler


	
RSS Popper for Microsoft Outlook 2007







	
Note:

Oracle Beehive requires a reader that supports authenticated feeds. (Outlook 2007 alone does not seamlessly support authenticated feeds and therefore, is not supported.) However, Web-based RSS readers (such as reader.google.com) may not be able to traverse firewalls into the Beehive server.












Mobile Access

It is possible to manage your Email, Calendar, and Task list; use instant messaging and access documents through standards-based clients on mobile devices. Apple iOS devices, Android devices, and Nokia Symbian based devices all include differing levels of support. For a complete list of Beehive supported devices and additional configuration information, refer to Configuring Mobile Devices Help.






Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.


Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.
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